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1 Introduction

1.1

D-Case Editor User’s Manual

What is this manual?

This manual describes how to install and how to use ‘D—Case Editor’ which is an assurance

case editor having type checking feature.

1.2 Definition

Term

Description

Diagram

Visualized representation of D—Case.

D-Case Document

A file which describes D—Case and/or its module.

GMF Diagram Information
File

A file which represents layout information, such as position, size or color of
each element in D—Case and/or its module. The filename format is ‘D-Case
name or module name.dcase_diagram’ .

GMF Model Information File

A file which describes logical structiure of each element in D-Case and/or its
module. The filename format is ‘D—Case name or module name.dcase_model’ .

Attribute

Property information of node or link.
Ex.) Name, Desc, Attachment, Userdef001~016, Etc.

Pallet viewer

A functional module which enables users to select nodes or links in D—Case
Editor visually in Eclipse environment.

View

A functional module which provides tabbed information in Eclipse environment.

Preference store

A data storage area in Eclipse environment which stores plugin settings
according individually in Eclipse workspace.

1.3

Related Documents

Matsuno Yutaka, Takai Toshinori, Yamamoto Shuichiro, D-Case for beginners (in Japanese),
Daitec Holdings Co., Ltd (Free of Charge), ISBN978-4-86293-079-8

D-Case Website (http://www.dcase.jp/)

The Eclipse Foundation (http://www.eclipse.org/)

JRE java.com (http://java.com)
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2 How to Install

2.1  System Environment

This manual is based on following system environment to install D-Case Editor.

*Note: GMF Runtime and OCL Classic SDK will be installed automatically together with D-Case
Editor.

Microsoft® Windows® 7 Professional SP1

Oracle Java SE Runtime Environment 7 Update 75
Eclipse IDE for Java Developers (4.4.2 / Luna 32bit)
Graphical Modeling Framework(GMF) Runtime (1.8.1)
OCL Classic SDK (5.0.2)

Pattern project (D-CasePattern.zip)

Extractor utility for zipped file

2.2 Installation

At the beginning, prepare a Windows PC in which JRE (Java Runtime Environment) has been
installed.

Installing Eclipse

1. Go to Eclipse official website and click ‘Downloads’ to download ‘Eclipse IDE for Java
Developers’. This manual downloads an archive file for Windows 32bit.

2. Unzip the archive file.

3. Execute ‘eclipse.exe’

Installing D-Case Editor Plugin
1. Start Eclipse.

2. Select ‘Install New Software...” in ‘Help’ menu.

3. Type ‘http://dimensions-japan.org/dcase/eclipse/’ in ‘Work with’ area.

4. Check ‘D-Case Editor’ and proceed. If it does not appear, uncheck ‘Group items by
category’.

5. Click ‘OK’ when following dialogue appears.

@® Secuyrity Warning

Warning: You are installing software that contains unsigned content. The
0 authenticity or validity of this software cannot be established. Do you want
to continue with the installation?

E770ok ]| petails>> || cancel
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Importing Pattern Project
1. Start Eclipse.

2. Select ‘Import..."” in ‘File’ menu.
3. Open ‘General’ and select ‘Existing Projects into Workspace’. Then click ‘Next’.
4. Check ‘Select archive file” and click ‘Browse...". Then select the archive file of patter project

named ‘D-CasePattern.zip’.

5. Check ‘Copy projects into workspace’ and click ‘Finish’.
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3 Basic Usage

3.1 Creating New Project

You can create new project to handle D-Case document by following steps.

l. Click ‘File’ menu and select ‘New’—’Project’
2. Click ‘General’ and select ‘Project’ and click ‘Next’.
3. Type your project name in ‘Project name’ and click ‘Finish’.

3.2 Creating D—Case Document

You can create new D-Case document by following steps.

1. Right-click the project you just created in subsection 3.1 and select ‘New’—’Other...".
2. Open ‘D-Case Editor’ and select ‘D-Case Diagram’ and click ‘Next’.

3. Input filename in ‘File name’ area and click ‘Next’. Note that you should not rename the
filename extension which is originally set as ‘.dcase diagram’.

4. Click ‘Finish’.

3.3 Creating Node and Link

Soon after creating D-Case document as described in subsection 3.2, you will see the D-Case editor
as shown in Fig.1
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Fig.1 D—Case Editor

To add a node, select a node you need from ‘Palette’ list and click any position in a white canvas on
the middle of the screen. The node will be set on that position.

To add a link which shows the relation between nodes, select a link from ‘Palette’ list in the same
manner. Next, drag between nodes to be connected. Otherwise, right-click a node and select ‘Add
Child’—’Create a New Node’ and select a new node so that both nodes will be connected each
other (Fig.2).
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Fig.2 Adding a child

You can double-click some node to change properties of the node as shown in Fig.3.

= Set properties

=

MName: IG_W |
Desc
4
more...

Desc Format Sthing

Attachment:

Resronsikility Name
Responsibility Address

Responsibility lcon
Walid Until
Soript

.L

MName

|\f'a|ue

| Tyvpe | MNode |

[ ok 1]

Cancel |

Otherwise, you can also
view by clicking ‘Window’
‘Other...”—“General’— ‘Properties’ (Fig.4).

Fig.3 Properties

open the properties
— ‘Show View’ —
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Property | Valus
= Info
derived false
editable true
last modified Apnl 14, 2015 2t 10:01:17 P
linked falss
location C¥Users¥machookpro¥edlipse workspace¥test Doase¥default dcase diagram
name default.dcase diagram
path Fest Dease/default dease diagram
size 534 bytes

Fig.4 Properties view

3.4 Automatic Diagram Arrangement

Automatic diagram re-arrangement is available for D-Case document. Click ‘Diagram’—
‘Arrange’— ‘All’ to re-arrange the document automatically and vertically (Fig.5).

od-1:G1 OoJ-1:G1
[Undefined] [omizc1 | [Undefined]
[Undefined]
FETER [ & wes 1 / [omsca
[Undefined] [Undefined] [Undefined]
OJ—n:6_2 OI—:G_3
OJ-n:G.2 O03-n:G_3 [Undefined] |Undefined]
[Undefined] [Undefined]

o

Fig. 5 Automatic arrangement of D—Case document

Also you can click ‘D-Case’ —*Arrange direction’— ‘Horizontal’ to arrange the document
automatically and horizontally.

4 Modules

41 What are Modules?

A module handles multiple sub-trees of D-Case to help users easily recognize and manage
complicated D-Case having large number of nodes.

10
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A module is composed by GMF diagram information file whose suffix is ‘dcase_model’ and by
GMF model information file whose suffix is ‘dcase_model’, as with normal D-Case. When you
divide a D-Case into multiple modules, two module files appear; one module file includes top node
and another module file includes is divided piece.

42 Modularization

There are two ways for modularization. One is a modularization of D-Case subtree; you can
simplify complicated D-Case by substituting subtree(s) into module(s). Another is setting reference
information for a Module node or Goal node (so-called Away Goal node) after adding these nodes.

To modularize D-Case subtree, right-click a root node on a sub-tree and select ‘Create Module’ as
shown in Fig.6.

;s 1
4rsl  Add Note
File

Edit

Delete from Diagram
Delete from Model

-; Format »
c Create Module
N-Cace NR b

Fig. 6 Right—clicking a root node

On a diagram box (Fig.7), type your module name and click ‘OK”.

Type Module name.

Module Name: ||

Cancel OK

Fig.7 Module name dialogue box

Then a new subtree will be created as a module and the original subtree in the D-Case will be
substituted as a Module node, as shown in Fig.8.

Design of Feil uver Function 1—*{ Specification of i Module:6_23 :
satisfies the specification, Fail Over Function Design of Fal Over Function
satisfies the specification.

G_23

O GoakG_23 O Context:C_6 } L ./

O Evidence:E_6
Result of design review

Fig.8 Modularization of subtree
11
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To set reference information for a Module node or Goal node, right-click the added node and click
‘Attachment’—’Select from Module...” as shown in Fig.9.

Add child S -
Convert Node Type »
Show/Hide Children » T LR L] Y T [
Parameters » Select from Web...

Open
DSBench . g create a local task.
Show Properties View sl ou i5Te 8 = O

Fig.9 Module selection

Select the node from node list to be referred. Note that the node to be referred should be ‘Public
node’. You can set a node as ‘Public node’ by right-clicking the node and select ‘Set Public/Private
Flag’—’Public’. If you do not want that the node will be referred, select ‘Private’.

4.3 Module Expansion View

To see details, such as referring module or node contents, of a Module node or Away Goal node,
right-click the node and select ‘Show/Hide Module’ —’Show Module’ (Fig.10).

Restore Module

Set Flags >
Show/Hide Module tl  Show Module
Adjust Reference Hide Module

Show Properties View

Fig.10 Module expansion menu

Then, reference information of the module will appear as shown in Fig.11. It will disappear by
clicking ‘Hide Module’.

12
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\-\‘“ I
Fi Moduleztest3-1 ~l fn Moduleitest3-1
HOEEEALT HREEEALT
test3-1 test3-1

O GoakG_11
HREEArT

|

I StrateqyS_ S
HREEOANIRESETS

O GoalG_12 O GoalG_13
Y= HNTRIEIN TS AN —UHRADI EREINTLE

Fig.11 Module expansion view

44 Canceling Modularization

You can cancel a modularization and restore a Module node to an original subtree by right-clicking
the Module node and select ‘Restore Module’ as shown in Fig.12. Not that the module file to be
referred will not be deleted automatically in this process. To delete the module file, see next
subsection.

Edit >
Delete from Diagram

Delete from Model

Format »
Restore Module

Nrace NR b

Fig.12 Canceling modularization

4.5 Module Management

The ‘Modules view’ shows list of modules and public nodes in a D-Case project and provides
manipulation feature for the listed items. It helps users to understand logical relation of nodes. To
see ‘Modules view’, Click ‘Window’—’Show View’—’Other...", and expand ‘D-Case Editor’ menu
and click ‘Modules’ as shown in Fig.13.

13
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ltype filter text
b & cvs
' 7 Benchmark Results
1 D-Case DB
l = Modules I
] Requirements

L b ¢

O Templates

7 Test Scenarios
b = Debug
= = General

Ll Bookmarks =]

Fig.13 Modules view selection

Fig.14 shows an example of Modules view.

¥ Tasks [ Properties | T Modules £2 | El Console = 5 2 el
Name Node# Link# Reference ‘
K3 main 9 0

main/G_1 1 test5/G_9
[ main2 6 1 main/D_1

main2/G_5 0

Fig.14 Modules view

Modules view lists module name, public node name, number of nodes in the module, number of
links and referring source node (module name and node name).

You can open a module by double-clicking it. You can delete a module by clicking ‘X’ only if the
module is not referred (e.g. number of links is 0).

46 Exporting Node List
To export a node list, select ‘File’—’Convert File Type’ —’From GMF to Text’ as shown in Fig.15.

14
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g2y Import...

24 Export.. .f Console [ Propsrties 3 .!-_ Za—)l pLe-
Convert File Type b Frem GMF To D-Case Model
Properties Alt+Enter Fromn D-Case To GMF Model

From Old GMF To New GMF Model
From GMF To SACM
From GMF To ARM

From GMF To Text

XSL Transferm From GMF Model »

1 newsample.dcase_diagram [D-CasePattern]
2 sub.dcase_diagram [test20131125/all]

3 main.dstar_diagram [test20131125]

4 functionality.dcase_diagram [test20...]

Exit

Fig.15 Exporting node list

Then the wizard will appear (Fig.16).

xXno Convert Model To Text Format Wizard

Conversion File Definition Page

Enter input model file path.

Input : GMF Format Model File

Browse...
Output : Text Format File
Browse...
Option
overwrite output model file.

@ Cancel

Fig.16 File exporting wizard

Input a GMF model information file name and text file name for exporting and click ‘Finish’.

Following is the example of the text file. It contains one node information on one line; node name,
Desc and Attachment (Referent).

15
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[Goal]

> nn

“G_117,”fault—tolerance satisfaction” ,

nn

“G_127, "redundancy of all servers” ,

nn

“G_13", "RAID1 redundancy of storages’ ,

[Strategy]

nn

“S_ 5”7 ”7classification of fault-tolerance metrics” ,

[Module]
‘(M_l//, ////, //modulel//

Omitted below...

16
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5 Pattern

5.1 What is Pattern?

You can set ‘Patterns’ for a D-Case to be used frequently. D-Case Editor handles ‘Patterns’ in ‘D-
Case pattern’ project.

5.2 Adding Patterns

To add a pattern on a diagram, right-click any position in the diagram and select ‘Add Pattern’ as
shown in Fig.17, aAd select a pattern to be added from a list.

Calculate the Score
Attachment

hd

w

Add Pattern

Fig.17 AddPattern menu for a diagram

|  Redmine 4

To add a pattern under a node, right-click any node and select ’Add Child’—’ Add Pattern to node’
as shown in Fig.18, and select a pattern to be added from a list.

L= by

Format » - S—
add d »
Convert Node Type 14 Add Pattern to node !
Attachment 4 Add Pattern »
d>  show/Hide Children » Develop Sub-goals from the Component Diagram
.2 parameters » rTWDTn?TaVFum 209778 Z0°56:0T)

Fig.18 Pattern adding menu

5.3 Pattern Node

You can add multiple patterns using ‘Pattern’ node in a subtree having a root node which is linked
with the Pattern node by ‘InContextOf” link.

Pattern node has SubType property whose value would be ‘Parameter’, ‘Loop’, ‘Choice’ or
‘Multiplicity’. For more information about ‘Parameter’ property, see Section 6.

‘Loop’ property is used to add target subtree as a pattern onto some leaf node repeatedly as shown

in Fig.19. You can select the leaf node to be modified by clicking a node and select ‘AttributeDialog’
— ‘LeafNode’ property’. A dialogue will ask you the number of loop of pattern addition when you
add patters

17
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Pattern with loop

Instantiation I/

Fig.9 Loop process

‘Choice’ property is used to add a part of target subtree as a pattern as shown in Fig.20 where n is
number of nodes in target subtree. You can set n, i and j properties on ‘AttributeDialog’.

Pattern with choice

Instantiation

Fig.20 Choice process

‘Multiplicity’ is used to add patters by duplicating target subtree as shown in Fig.21. You can set i
and j properties on ‘AttributeDialog’.

18
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Pattern with multiplicity

Instantiation

multiplicity
node

k times

O<isj isk=]j

Fig.21 Multiplicity process
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6 Parameters

6.1 What are Parameters?

Parameters are used to abstract modules and/or patterns to re-use them easily on various D-Case
systems. You can define Parameters and set their values on ‘Pattern’ node. The Parameters you
created can be used in a tree having a root node which refers Pattern node by “InContextOf” link. If
modularized, you can track all parameters by tracking parent modules. If multiple parameters have a
same name, closer node parameters are used.

6.2 Parameter Definition and Setting

To define Parameters, right-click a Pattern node and select ‘Parameters’—’Define Parameters...” as
shown in Fig.22.

Show/Hide Children .

Set Parameters...
Define Parameters...

Select subtree

Create Module Show Parameters...
Set Flags >
— Show/Hide Module .

Fig.22 Parameter definition menu

Then a parameter setting dialogue appears (Fig.23).

an |
S |

seven |[ ok ]

Fig.23 Parameter setting dialogue

Click ‘Add’ to add parameters by typing parameter name, value and type.
Click ‘Edit’ to modify the definition of a Parameter.
Click ‘Delete’ to erase the Parameter.

To change values of Parameter, right-click the Pattern node and select ‘Parameters’—’Set

20
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Parameters...” and re-type values on a dialogue.

6.3 Parameters’ References

In ‘AttributeDialog’, ‘Desc’ attribute is set according to ‘Desc Format String’ attribute; string value
written in ‘ {parameter name}’ formatted text in ‘Desc Format String’ attribute will also be used in

‘Desc’ attribute as a parameter value. ‘AttributeDialog’ also lists available parameters in a node as
shown in Fig.24.

xa Set properfies

Name: (A_1

Desc:

¥ more...

Attachment: Browse...
Status:

Responsibility:

Desc Format String:

Script:

Name Value Type Node
uistr U135 string  test2/u_1
sSstr test2dDS5& string  test2/S_5
g10int 100 int test2/G_10
attachmentDoub 100.00 double testi
attachmentRaw aaaa raw test1

Cancel OK

Fig.24 AttributeDialog (Set properties)

The dialogue shows parameter name, value, type and node information (‘module name / node name’
formatted), and does not show parameter information which is not able to be referred.

Click a parameter to copy the ‘Name’ onto the clip board. Double-click the parameter to copy
‘{Name}’ onto the clip board, that may be useful to set ‘Desc Format String’ attribute.

21



D-Case Editor User’s Manual
7 Others

7.1 Language Setting

D-Case Editor is a multilingual application. It runs in Japanese or English mode according to your
Windows system setting. To change the language mode, set an option for Eclipse on command line
as followings.

Japanese mode

$ eclipse -nl ja

English mode
$ eclipse -nl en

b

If you want to see all Eclipse menu in Japanese except D-Case Editor, you also can install ‘Pleiades
from following URL.

http://mergedoc.sourceforge. jp/

7.2 Previous Version Compatibility

Without file format converting, you cannot directly open D-Case data (GMF diagram information
file and GMF model information file) created by previous version if D-Case Editor (before version
0.8.15), since previous version has different schematic data from current version. To convert the file
format from previous version to current version, select ‘File’—’Convert File Type’— From Old
GMF to New GMF Model’ as shown in Fig.25.

g2y Import...
i3 Export... ] Properties I3
Convert File Type » From GMF To D-Case Model
Properties Alt+Enter From D-Case To GMF Model
l From Old GMF To Newy GMF Model I
1 newsample.dcase_diagram [D-CasePattern] From GMF To SACM
2 sub.dcase_diagram [test20131125/all] From GMF To ARM
3 main.dstar_diagrarm [test20131125] From GMF To Text
4 functionality.dcase_diagram [test20...] SL Transform From GMF Model "
Exit

Fig.25 File format transforming

Then, the converting wizard appears (Fig.26).

22
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2 Convert Model To New GMF Format Wizard A

SEoE )
Conversion File Definition Page
Enter input model file path.
Input : GMF Format Model File
Browse...

Output : GMF Forrnat Model File

Browse...

Optien
overwrite output file

7 Cancel

Fig.26 File converting wizard

Type or select previous version GMF model information file, and set output filename and click
‘Finish’. After that, right-click the GMF model information file and select ‘Initialize dcase diagram
diagram file’ as shown in Fig.27.

all.dcase_model : 'El;pp;t"
functionality.dcase_mod:
£ main.dstar_diagram ' & Refresh FS
main.dstar_rmodel Assign Working Sets...
Validate
| Initislize dcase_diagrarn diagram file
Debug As 4

Fig.27 Initializing D—Case diagram file

To prevent confusion in Modules view or d*, you should not store both old version file and new
version file in a same project.

7.3 Converting to SACM

To convert D-Case document to SACM (Structured Assurance Case Metamodel) file, as shown in
Fig.25, select ‘File’—’Convert File Type’, and select ’From GMF to SACM’.

If you want to create expanded SACM which supports Parameters, select ‘From GMF to ARM’.
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